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Accessing items in Corel GALLERY
Corel GALLERY provides three different pages you can use to access clipart, photos, Web images, animations, 
sounds, and videos included on the Corel GALLERY 1,000,000 CD-ROMs: the Search page, the Browse page, and 
the Favorites page. The Search page helps you find items that share common subject matter. The Browse page 
lets you view items by categories on the CD-ROMs. The Favorites page lets you quickly access the items you use 
most often.
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Using the Search page

The Search page lets you find clipart and photos by searching for keywords. For example, if you want to find a 
photo for a newsletter about owning pets, you can search for the keyword "dogs" or "cats"; or you can even use 
both keywords to search for photos that have both dogs and cats. You can search though individual categories, 
any one of the Corel GALLERY 1,000,000 CD-ROMs, or search the entire collection of Corel GALLERY 1,000,000 
CD-ROMs. Thumbnails of the items found by your search are displayed in the Thumbnail View area of the Search 
page.

 Tip
· You can switch to the Search page from another page by pressing ALT + S.
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Accessing items using the Search page
In the Search page, you use keywords to find clipart and photos available on the Corel GALLERY 1,000,000 CD-
ROMs. Keywords are descriptive terms that are assigned to the clipart and photos on the Corel GALLERY 
1,000,000 CD-ROMs. When you search for one or more keywords, Corel GALLERY displays clipart or photos that 
match your search.
You can use multiple keywords when performing a search. Type as many keywords as you need, with a space 
between each one.
In the Search page, you can search for sounds, videos, and animated GIFs by format only, not by subject. For 
example, you can search for WAV sounds, or AVI videos, but not sports sounds, or business videos.

To access items in the Search page
1. Click the Search tab.
2. Type the word(s) you want to search for in the Search For box.
3. Choose one of the following categories from the In list box:

· Clipart searches clipart only
· Photos searches photos only
· All Categories searches clipart and photos

4. Choose one of the following options from the Matching list box:
· Any returns items that contain one or more of the keywords chosen

· All returns items that contain all the keywords chosen
5. Choose one of the following options from the Keyword list box:

· Exactly returns items with keywords that match the word(s) in the Search For box exactly
· Partially returns items with keywords that match the word(s) in the Search For box, and items with 
keywords that contain the word(s) in the Search For box

6. Click Start.

To search for sounds, videos, and animated GIFs
1. Click the Search tab.
2. Type one or more of the following words in the Search For box.

· sound, wav, midi search for sounds
· video, movie, avi search for videos
· animated searches for animated gifs

3. Choose All Categories from the In list box.
4. Choose Any from the Matching list box.
5. Choose Exactly from the Keyword list box.
6. Click Start.

 Notes
· The images in the WebSpice Collection do not have keywords, and are not included in searches done from the 

Search page.
· The Search For box lists the last ten keywords you entered. You can search for a previous keyword by choosing

it from the Search For box on the Search page.
· For information about changing the settings for your searches, see Customizing searches.

 Tip
· When you view details about icons, you can view a column that shows you the relevance of the search results 

to your search criteria. To view details about icons, click View, Details.
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Searching for items from the Corel GALLERY 1,000,000 User Guide
Once you have customized Corel GALLERY to search for filenames in the Corel GALLERY 1,000,000 User Guide, 
you search for the name of any file that appears in the Corel GALLERY 1,000,000 User Guide.
When you perform a search with the Search File Names (Only Exact Match Performed) check box enabled, Corel 
GALLERY searches for the exact filename and, for items that have the filename as a keyword. Some of the search
settings you choose on the Search page are applied to the keyword search only. The file name search only 
returns exact matches. For example, if you type "Pig" in the Search For box, the item with the file name PIG.GIF 
will be returned, but not the item PIGEON.CCX, even if you choose "Partially" from the Keyword list box.
The setting you choose from the In list box applies to the file name search. For example, if you want to search for
a button or theme from the Corel GALLERY 1,000,000 User Guide, you have to choose "All Categories" from the 
In list box. If you choose "Photos," then Corel GALLERY only searches the photos.

To customize Corel GALLERY to search for file names in the Corel GALLERY 1,000,000 User Guide
1. Click View, Search Settings.
2. Enable the Search File Names (Only Exact Match Performed) check box.

To search for a file in the Corel GALLERY 1,000,000 User Guide
1. Click the Search tab.
2. Type the filename in the Search For box.
3. Choose All Categories from the In list box.
4. Choose All from the Matching list box.
5. Choose Exactly from the Keyword list box.
6. Click Start.

 Note
· The files that appear in the WebSpice section of the Corel GALLERY 1,000,000 User Guide are shown as 

examples only. You cannot perform a search on the filenames that appear in this section.



Opening images and folders using the Search page
You can open images and folders using the Search page. When you open an image, it launches in its associated 
application. When you open the folder in which an image is stored, it opens in Windows Explorer.

To open an image using the Search page
· Double-click the image's thumbnail in the Thumbnail View area.

To open the folder in which an image is stored
· Click the image's thumbnail in the Thumbnail View area, and click File, Open Containing Folder.
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Customizing searches
You can customize the searches you perform on the Search page by changing your search settings. Customizing 
a search lets you change the extent of your searches and lets you add and remove CD-ROM drives from Corel 
GALLERY searches.
When customizing Corel GALLERY to access the Corel GALLERY 1,000,000 CD-ROMs over a network, you must 
specify the network path to each Corel GALLERY 1,000,000 CD-ROM.

To add a CD-ROM drive to the search
1. On the Search page, click Edit, Search Settings.
2. Click a CD-ROM drive in the Search Paths box.
3. Click the Add button.

To remove a CD-ROM drive from the search
1. On the Search page, click Edit, Search Settings.
2. Click a CD-ROM drive in the Paths To Library Content box.
3. Click the Remove button.
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Using the Browse page

The Browse page lets you find clipart, photos, Web images, animations, sounds, and videos by searching through
folders, similar to how you use Windows Explorer. For example, if you want to find clipart for a brochure for a 
store that sells musical instruments, you can put a Corel GALLERY 1,000,000 CD-ROM in your CD-ROM drive, 
then use the Browse page to open the CLIPART folder, then the MUSIC folder. Thumbnails of the items in the 
folder are displayed in the Thumbnail View area of the Browse page.

 Tip
· You can switch to the Browse page from another page by pressing ALT + B.
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Accessing items using the Browse page
The Browse page lets you find items by looking in the category folders on the Corel GALLERY 1,000,000 CD-
ROMs. This is a useful way to find items when you know where they are stored or when you want to view all the 
thumbnails in a category.

To access items using the Browse page
1. Click the Browse tab.
2. Double-click the drive in which the item is stored.
3. Double-click the folder in which the item is stored.
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Opening images and folders using the Browse page
You can open images and folders using the Browse page. When you open an image, it launches in its associated 
application. When you open the folder in which an image is stored, it opens in Windows Explorer.

To open an image using the Browse page
· Double-click the image's thumbnail in the Thumbnail View area.

To open the folder in which an image is stored
· Click the image's thumbnail in the Thumbnail View area, and click File, Open Containing Folder.
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Playing sounds and videos using the Browse page
You can play sounds and videos using the Browse page. When launched, the sound or video will play on the 
associated media player on your computer.

To play a sound using the Browse page
· Double-click the sound's thumbnail in the Thumbnail View area.

 Note
· In order to hear Corel GALLERY 1,000,000 sounds, you must have a sound card and speakers installed on your 

computer.

To play a video in the Browse page
· Double-click the video's thumbnail in the Thumbnail View area.

 Note
· The videos in Corel GALLERY 1,000,000 do not have sound.
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Using the Favorites page

The Favorites page gives you instant access to clipart, photos, Web images, animations, sounds, and videos 
stored in your Favorites folders. When you find an item that you like, you can add a shortcut to it to a Favorites 
folder; then whenever you want to use that item, you can access it without having to browse to or search for it. 
For example, if you are creating seven versions of a restaurant menu, you can add the clipart you want to use in 
each version of the menu to a Favorites folder.
The folder GALLERY FAVORITES is automatically created when you install Corel GALLERY 1,000,000. You can store
shortcuts to all your favorite items in this folder, or you can create folders within the GALLERY FAVORITES folder 
to help you organize your favorite items. For example, if you want to keep your children's favorites in a separate 
folder, you can create a folder named KID'S FAVORITES.

 Tip
· You can switch to the Favorites page from another page by pressing ALT + A.
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Accessing items using the Favorites page
In the Favorites page, you can access items that you have added to your Favorites folders. The Favorites page 
lets you keep track of items that you want to use again, and allows you to access these items quickly. You do this
by adding items you like to Favorites folders.

To access items in a Favorites folder
1. Click the Favorites tab.
2. Double-click the Favorites folder you want to open.
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Opening images using the Favorites page
You can open images using the Favorites page. When you open an image, it launches in its associated 
application.

To open an image using the Favorites page
· Double-click the image's thumbnail in the Thumbnail View area.
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Playing sounds and videos using the Favorites page
You can play sounds and videos using the Favorites page. When launched, the sound or video will play on the 
associated media player on your computer.

To play a sound using the Favorites page
· Double-click the sound's thumbnail in the Thumbnail View area.

 Note
· In order to hear Corel GALLERY 1,000,000 sounds, you must have a sound card and speakers installed on your 

computer.

To play a video in the Favorites page
· Double-click the video's thumbnail in the Thumbnail View area.

 Note
· The videos in Corel GALLERY 1,000,000 do not have sound.

{button ,AL(`PRC Using the Favorites page;',0,"Defaultoverview",)} Related Topics



Adding and removing items in the Favorites page
The Favorites page lets you quickly access clipart, photos, Web images, animations, sounds, and videos on the 
Corel GALLERY 1,000,000 CD-ROMs that you use often. When you find an item you are going to use on a regular 
basis, for example, in many different versions of a document, you can add it to the Favorites page. This way, 
when you want to use that item again, you can click on the Favorites tab, click on the appropriate folder, and the
thumbnail of the file will be displayed. 

To add an item to a Favorites folder
· Right-click the icon or thumbnail of an item in the Thumbnail View area in the Search page or the Browse 

page, and click Add To Favorites.

To remove an item from a Favorites folder
· Right-click a icon or thumbnail in the Thumbnail View area in the Favorites page, and click Delete.

 Note
· You can only add items on the Corel GALLERY 1,000,000 CD-ROMs to Favorites folders.
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Creating Favorites folders
When you install Corel GALLERY 1,000,000, the folder GALLERY FAVORITES is created automatically. You can 
create as many Favorites folders as you want in the GALLERY FAVORITES folder. For example, if you want to 
create wedding invitations and placecards, you can create a Favorites folder called WEDDING FAVORITES, in 
which you can store all the favorite clipart you want to use in the projects for the wedding.

To create a Favorites folder
1. Click the Favorites tab.
2. Right-click the background of the Thumbnail View area, and click New, Folder.
3. Right-click the New Folder, and click Rename.
4. Type a name for your folder, and press ENTER.
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Accessing fonts
Fonts in Corel GALLERY 1,000,000 can only be accessed through the Corel GALLERY 1,000,000 setup. You can 
install more fonts at any time by running the Corel GALLERY 1,000,000 setup program, choosing Full Setup with 
Fonts, and enabling the check boxes of the fonts you wish to install.
The fonts included in Corel GALLERY 1,000,000 are True Type fonts.

To install fonts included in Corel GALLERY 1,000,000
1. Insert Corel GALLERY 1,000,000 CD-ROM #1 in your CD-ROM drive.
2. Click the Start button on the Windows taskbar, and click Run.
3. Click the Browse button.
4. Choose your CD-ROM drive from the Look In list box.
5. Double-click SETUP.EXE.
6. Follow the instructions on your screen for a Full Setup With Fonts, and specify the fonts you want to install.

 Note
· A Full Setup With Fonts installs all of the applications included with Corel GALLERY 1,000,000 on your 

computer. You can uninstall these programs at any time.
· You can also install fonts by dragging them from the FONTS folder on the Corel GALLERY 1,000,000 CD-ROM 

Disc 1 to your Windows FONTS folder.
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Welcome to Corel GALLERY 1,000,000
Corel GALLERY 1,000,000 is a collection of clipart, professional photos, Web images, animations, sounds, videos, 
and fonts. Whether you are creating a brochure for your business, an invitation for an anniversary party, or an 
assignment for school, Corel GALLERY 1,000,000 has the right item for your project.
Corel GALLERY 1,000,000 includes Corel GALLERY, a program that gives you three easy ways to find the perfect 
clipart, photo, Web image, animation, sound, or video.
· Know what you're looking for? Navigate directly to where the item is stored on the Corel GALLERY 1,000,000 

CD-ROMs using the Browse page.
· Need items relating to a certain subject? Use the Search page to search for items on any subject by keyword.
· Want to use a certain item again? Add your favorite items to the Favorites page to keep them at your 

fingertips.
Using Corel GALLERY 1,000,000 items in files created with other applications word processing, spreadsheet, 
presentation, HTML editing programs, for example

is as easy as dragging the thumbnail of the item to the file you are creating.
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About Corel Corporation
Corel Corporation is recognized internationally as an award-winning developer and marketer of productivity 
applications, graphics, and Internet software. We pride ourselves in delivering high-quality products by actively 
seeking your input.

We want your feedback
If you have any comments or suggestions about Corel GALLERY 1,000,000 or Corel Photo House documentation, 
you can email them to gallery3@corel.ca or mail them to the address listed below. Unfortunately, we won't be 
able to respond to your messages individually, but you can check the Corel GALLERY 1,000,000 home page for 
the latest product news, Corel GALLERY 1,000,000 tips and tricks, and product upgrade information. You can 
access the Corel GALLERY 1,000,000 home page on the World Wide Web at http://www.corel.com/gallery3.
Corel GALLERY 1,000,000 Product Manager
Corel Corporation
1600 Carling Avenue
Ottawa, Ontario, Canada
K1Z 8R7
Corel ships its products through a network of more than 160 distributors in 70 countries worldwide. Corel is 
traded on the Toronto Stock Exchange (symbol: COS) and the NASDAQ National Market System (symbol: 
COSFF).

For more information about Corel and our products, check out our World Wide Web site at http://www.corel.com.
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What's in Corel GALLERY 1,000,000?
In addition to clipart, photos, Web images, animations, sounds, and videos; Corel GALLERY 1,000,000 includes 
the following applications:

Corel GALLERY
Corel GALLERY lets you
· search the Corel GALLERY 1,000,000 collection by using keywords to find items on the subject you want
· browse the Corel GALLERY 1,000,000 CD-ROMs
· access your favorite items instantly

Corel Photo House
Corel Photo House lets you
· edit scanned images, as well as images from CD-ROM libraries and digital cameras
· apply special effects to transform your images in unique and interesting ways
· crop, flip, rotate, and resize your images

The WebSpice Collection
The WebSpice Collection is an assortment of images you can use when you create Web pages. The WebSpice 
Collection includes
· arrows and buttons
· backgrounds
· bullets
· rules
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Using Corel GALLERY 1,000,000 documentation
Corel GALLERY 1,000,000 includes online and paper documentation to help you learn and use the program 
efficiently.
User Guide The Corel GALLERY 1,000,000 User Guide includes basic information and common 

procedures to get you started using Corel GALLERY 1,000,000.
Online Help The online Help system enables you to retrieve all the information you need 

quickly, and then return to your work. Help appears in a separate window on your 
screen. For quick access, you can keep the Help window displayed on top of the 
application window.

ToolTips ToolTips provide information about buttons on the toolbars. ToolTips display in a 
balloon when you position the cursor over a button.
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Documentation conventions
Before you start using Corel GALLERY 1,000,000, it's important to understand the conventions used in the 
documentation.

Mouse conventions
The following are conventions related to using the mouse:
When you see this ... Do this ...
Click File, Exit Click the File menu with the mouse, and click the word Exit in the menu.
Enable a check box Click the check box to place a check mark or an "X" inside the box.
Disable a check box Click the check box to remove the check mark or "X."
Choose a keyword from Click the Keyword(s) list box, and click the keyword you want.
the Keyword(s) list box
Right-click, and click Paste Click the right mouse button, and click the Paste command in the submenu that 
appears.

Keyboard conventions
The following are conventions related to keyboard actions:
When you see this ... Do this ...
Press ENTER Press the Enter key on your keyboard.
CTRL + SHIFT Press the Control key and the Shift key at the same time.

{button ,AL(`OVR Welcome to Corel GALLERY 1000000;',0,"Defaultoverview",)} Related Topics



Using online Help
The Help Topics dialog box, accessed by clicking Help, Help Topics, provides three ways to find information. You 
can select a topic from the Contents page, use the Index page to search for a topic, or use the Find page to 
search for specific words and phrases in Help topics.

To access Help topics
1. Click Help, Help Topics.
2. Click one of the following tabs:

· Contents to browse through topics by category
· Index to see a list of index entries, then type the first few letters of the subject about which you want 
information
· Find to search for a particular word or phrase in the online Help
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Printing Help
You can print specific Help topics or print entire sections of online Help.
To print an entire section
· On the Contents page, choose the section you want to print, then click the Print button at the bottom of the 

Help dialog box.
To print a selected topic
· Click the Print button at the top of the Help window, or right-click the window and click Print Topic.
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Corel services and support
Corel is committed to providing customers with high-quality technical support. The following sections describe 
the variety of support services available. The terms of Corel technical support offerings are subject to change 
without notice.

Classic technical support services
1-613-728-6173 (North America only)
One free technical support incident is available to Corel customers from Corel Technical Support. A support 
incident is defined as the resolution of one technical question, problem, or issue, regardless of the number of 
calls required to resolve it. Corel representatives are available to respond to your call from Monday to Friday, 
8:30 am. to 7:30 pm. Eastern Time.
During and after your Classic technical support period, you can also use the following services:
· Priority support services
· World Wide Web Site
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Priority support services

Corel offers the following technical support options, most of which are available 24 hours a day, 365 days a year.
These services are useful if you prefer not to pay for support or encounter problems during off-hours.

IVAN (Interactive Voice Answering Network)
The Interactive Voice Answering Network contains answers to commonly asked questions about Corel products 
and is available 24 hours a day, 365 days a year. It is regularly updated with the latest information, tips, and 
tricks. You can also request that IVAN's solutions be faxed to you. There is no charge for this service beyond the 
cost of the telephone call.
US/Canada 1-613-728-1937
Rest of world +353-1-708-2525 (Ireland)

Automated FAX On Demand
Technical Support maintains an Automated FAX On Demand system of numbered documents that contain up-to-
date information about common issues, tips, and tricks. This service is available 24 hours a day, 365 days a year.
(613) 724-3456
You will be asked for a document number and your fax number. The document you request is automatically faxed
to you. To have a catalog of documents faxed to your, call the Automated FAX on Demand system number and 
request document 2000.
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CompuServe
Interact with other users and Corel volunteers to obtain product information and support. CompuServe is 
available 24 hours a day, 7 days a week, including holidays. Corel volunteers will respond from 8:30 am to 5:00 
pm Eastern Time, from Monday to Friday, excluding holidays.
If you have a CompuServe membership, you can access Corel technical information by entering one of the 
following at the CompuServe prompt:
GO COREL (for English)
GO CORELGER (for German)
GO CORELFR (for French)
GO CORELLATIN (for Spanish)
GO CORELNL (for Dutch)
GO CORELSCAN (for Scandinavian)
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World Wide Web (WWW)
The World Wide Web address for Corel products on the Internet is http://www.corel.com. At this location, you 
can quickly search Corel's Searchable Knowledge Base. From the database, you can read, print, or download 
documents that contain answers to many of your technical questions or problems.
The following support services are also available on the World Wide Web:

Support Newsgroups
The Support Newsgroup, accessible from the Corel Web site, is intended to provide users the opportunity to 
exchange information, tips, and techniques with other users of Corel products. The newsgroup is located at 
http://www.corel.com/support/newsgroup.htm.

File Transfer Protocol (FTP)
You can download printer drivers and other files through our anonymous FTP site at ftp.corel.com.

AnswerPerfect
Customers can now submit support incidents (questions) by email to Corel's Web site for the introductory price 
of $9.95 US per incident, payable by credit card. This service is for English language products only. Corel is 
committed to responding to AnswerPerfect support incidents within one business day.
You can access AnswerPerfect support at http://www.corel.com/support/answerperfect.htm.
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Worldwide technical support
Corel customers residing outside North America can contact Corel Technical Support representatives in Dublin, 
Ireland, or a local Authorized Support Partner. Technical support outside North America is available to you at the 
following locations. If your country is not listed below, please check the Support section on our World Wide Web 
site at http://www.corel.com. You can also call (353)-1-7082500 for information about contacting Technical 
Support.

Priority technical support services
To request an up-to-date listing of Corel Authorized Support Partners worldwide, and a copy of Corel Priority 
Technical Support Policy, contact Corel Technical Support at (353)-1-7082500.
Latin America
Argentina (541) 954-6500
Brazil 011 5505 4725
Chile 562 236 1023
Columbia 5716196012
Mexico 01-800-2142673
Europe
Austria 01-589-241-30
Belgium(French) 02-714-41-30
Belgium(Dutch) 02-714-41-31
Czech Republic 420-2-312-3871
Denmark 35-25-80-30
Finland 92-29-060-30
France (1)-40-92-76-20
Germany 0180-52-58-211
Hungary 36 1 327 57 37
Italy 06-523-542-37
Ireland 01-7082600
Netherlands 020-5040570
Norway 22-97-19-30
Poland 0048 71 3477279
Portugal 0800853042
Russia 7 095 3782111
Spain 91-661-3627
Sweden 0680-711-751
Switzerland(French) 0848-80-85-90
Switzerland(German) 0848-80-85-90
United Kingdom 01923-209191
Rest of Europe (Ireland) (353)-1-7082600
Middle East
Dubai 971.4.366885
Israel 02-6793-723
Asia Pacific
Australia 60 2 98986860
Hong Kong 8100-3729
India 91 11 3351948
Indonesia 001 803 65 7266
Japan 03-5645-8379
Malaysia 1-800-80-1090



New Zealand 09 526 1155
Singapore 1-800-773-1400
South Korea 82-2-3444-678
Taiwan 886 2 2550 9500
Africa
South Africa 0860-223388

 Note
· The terms of Corel technical support offerings are subject to change without notice.
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Before calling Corel Technical Support
Before calling Corel Technical Support, please have the following information available. This information assists 
the Technical Support representative in helping you more quickly and efficiently:
· Brief description of the problem, including the exact text of any error messages received and the steps to 

recreate the problem
· Type of computer, monitor, pointing device (for example, mouse or tablet), printer, and video card (display 

adapter) in use
· Version of Microsoft Windows and the Corel product in use. In Windows Explorer, click Help, and choose About 

Windows 95 or About Windows NT
· List of any programs loaded into RAM. Check the Startup folder in the Programs menu to determine if you are 

running any other applications.
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Viewing program and system information
Corel GALLERY provides easy access to information about the application and your system.
Program information consists of the application name, version number, serial number, and user name. This 
information doesn't change. You'll find it particularly useful if you ever need help from Corel Technical Support 
Services.
System information consists of details about any of the following categories: system, display, printing, Corel .EXE
and .DLL files, and system .DLL files. For example, you can see how much memory you have on the drive to 
which you want to save a file. You can save any system information in a text file called SYSINFO.TXT.

To view program and system information
1. Click Help, About Corel GALLERY.
2. Click the System Info button to view system information.
3. Choose a category from the Choose A Category list box.

 Note
· Click Save to store system information for printing. System information is saved in the file SYSINFO.TXT. A 

message box tells you where the file is saved.
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Customer service worldwide
Corel Customer Service is operated by a number of third-party companies on behalf of Corel. If you would like 
more information about Corel products or services, please call one of the telephone numbers listed below. If your
country is not listed, please call the general number listed below. General customer service and product 
information can also be accessed through the World Wide Web at http://www.corel.com. You can email 
Customer Service at custerv2@corel.ca.

Corel Head Office
Corel Corporation
Corporate Headquarters
1600 Carling Ave.
Ottawa, Ontario
Canada
K1Z 8R7
Fax:1-613-761-9176
1-613-761-1295
Country Call this number
General (Ireland) +353-1-706-3912
Argentina 0-800-3-9192
Australia 1-800-658-850
Austria 0660-5875
Belgium 0800 11930
Canada 1-800-772-6735
Denmark 800 187 55
Finland 0800-1-13502
France 0800 530096
Germany 0130 815074
Hong Kong 810-COREL
Ireland 1800-242800
Italy 06-52362602
Japan 03-5645-8567
Luxembourg 0800-2213
Mexico 1-800-024-2673
Netherlands 0800 0222084
New Zealand 0800-COREL-1
Norway 800 11661
Portugal 05055-3001
South Africa 0800-23-4211
South Korea 82-2-344-6781
Spain 900 95 35 38
Sweden 020 791 085
Switzerland 0800 558224
United Kingdom 0800-581028
United States 1-800-772-6735
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Getting started
Corel GALLERY lets you find the clipart, photos, Web images, animations, sounds, and videos you want quickly 
and easily. Before you get started in Corel GALLERY, you should be familiar with the following concepts:

Clipart
Clipart images are ready-made images for use in all kinds of applications. Corel GALLERY 1,000,000 clipart are 
vector images, stored in Corel Compressed Exchange file format (.CCX). This format is ideal for use in 
CorelDRAW, Corel PHOTO-PAINT, and Corel VENTURA 8. Corel GALLERY can also convert clipart to formats that 
can be used in other applications, such as Corel WordPerfect and Microsoft Office applications.

Photos
Corel GALLERY 1,000,000 photos are bitmap images, stored in Wavelet Compressed Bitmap file format (.WI).

Vector images and bitmaps
For information about the difference between vector images and bitmaps, see Understanding vector and bitmap 
images.

Web images
Web images are images for special use in HTML documents. Corel GALLERY 1,000,000 Web images are stored in 
GIF format (.GIF).

Animations

Animations in Corel GALLERY 1,000,000 are animated GIFs Web images that move. You can incorporate Corel 
GALLERY 1,000,000 animated GIF files into HTML documents as you do other image files.

Sounds
Sounds included in Corel GALLERY 1,000,000 are stored in two file formats: MIDI (.MID) and Wave (.WAV). Sound 
files can be played using Microsoft Windows Sound Recorder or a compatible application on your computer.

Videos
Corel GALLERY 1,000,000 videos are stored in Video for Windows file format (.AVI) and played using the Microsoft
Windows Video Recorder or a compatible application on your computer.

Fonts

A font is a set of characters that usually includes the alphabet and several other symbols. Each font has different
characteristics that change its appearance. The font you choose for your text can completely change the mood 
of your message.

Examples

Thumbnails
Thumbnails are small, low resolution images displayed in the Thumbnail View area on the Corel GALLERY desktop
to represent items on the Corel GALLERY 1,000,000 CD-ROMs. Thumbnails let you preview images, that is, 
clipart, photos, Web images, and animations. 

Icons
Icons are pictorial representations of Corel GALLERY 1,000,000 items.
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Understanding vector and bitmap images
This section outlines the differences between vector images, such as the clipart included in Corel GALLERY 
1,000,000, and bitmap images, such as the photos included in Corel GALLERY 1,000,000.
If you haven't worked with image-editing programs, you'll find this section especially informative.

What is a vector image?
Vector images, also called object-oriented or draw images, are defined mathematically as a series of points 
joined by lines. Graphical elements in a vector file are called objects. Each object is a self-contained entity, with 
properties such as color, shape, outline, size, and position on the screen included in its definition.
Since each object is a self-contained entity, you can move and change its properties over and over again while 
maintaining its original clarity and crispness and without affecting other objects in the image. 

What is a bitmap image?
Bitmap images, also called raster or paint images, are made of individual dots, called pixels (picture elements), 
that are arranged and colored differently to form a pattern. When you zoom in, you can see the individual pixels 
that make up the total image. Increasing the size of a bitmap increases individual pixels, which makes lines and 
shapes appear jagged. Reducing the size of a bitmap also distorts the original image because pixels are removed
to reduce the overall image size.
Because a bitmap image is created as a collection of arranged pixels, you cannot change the size, shape, or 
location of individual pixels. You can, however, refine and apply effects to the entire image.

This illustration shows the difference between vector and bitmap images. 1) Vector image 2) Bitmap 3) Some of 
the shapes used to make 1 4) A close up showing the pixels in 2
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Exploring the Corel GALLERY desktop
Click a tool on the Corel GALLERY desktop to see a description of it.

Depending on the operating system you are using, for example, Windows 95, Windows 95 with Internet Explorer 
4.0, Windows 98, or Windows NT, you will notice that various options or buttons differ slightly. For example, the 
View button in Windows 98 contains a submenu with five view modes, while Windows 95 displays five individual 
buttons. Shortcut keys may also be different. These differences do not affect the application's functionality; they 
merely reflect the Windows environment that you are using.
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Viewing the Toolbar and Status Bar
The Toolbar gives you quick access to many Corel GALLERY menu commands. The Status Bar, in the lower left 
corner or the desktop, shows information about such things as objects, ongoing operations, and mouse position.
You can display the Toolbar and Status Bar, or you can hide them to make the Thumbnail View area larger.

To display the Toolbar
· Click View, Toolbar.

When the Toolbar command in the View menu has a check mark beside it, the Toolbar is displayed.

To display the Status Bar
· Click View, Status Bar.

When the Status Bar command in the View menu has a check mark beside it, the Status Bar is displayed.

{button ,AL(`PRC Getting started;',0,"Defaultoverview",)} Related Topics



Viewing and hiding the Hints bar
The Hints bar at the left side of the Corel GALLERY desktop gives you useful hints about searching for Corel 
GALLERY 1,000,000 items. You can hide the Hints bar. If you hide the Hints bar, the Welcome To Corel GALLERY 
1,000,000 hint will still appear if you have not performed a search.

 Note
· If the Welcome To Corel GALLERY 1,000,000 hint appears in the Thumbnail View area, it will not interfere with 

your search. Perform your search as usual.

To hide or display the Hints bar
· Click View, Hints Bar.

A check mark next to the Hints Bar menu item indicates that the Hints bar is enabled.
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Working with Corel GALLERY 1,000,000 items
Once you have found the clipart, photo, sound, or video you want to use, you can easily add it to projects you 
create using word processing, spreadsheet, presentation, drawing, image-editing, or desktop publishing 
applications.
Corel GALLERY also lets you save Web images and animations to your computer, rename them, and print them 
from their associated applications.

{button ,AL(`OVR Working with Corel GALLERY 1000000 items;',0,"Defaultoverview",)} More 
Detailed Information



Working with clipart and photos



Working with clipart and photos
Corel GALLERY lets you add clipart and photos to projects created in other applications, such as a word 
processing document, or a slide show. You can use Corel GALLERY to save these items to your computer. You can 
also open Corel GALLERY clipart and photos in their associated applications.
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Adding clipart and photos to your projects
Corel GALLERY gives you three ways to add clipart and photos to your projects. You can drag an item from the 
Corel GALLERY desktop to the destination application; copy an item to the Clipboard, then paste it into the 
destination application; or convert the item to a file format you can open in the destination application.

 Note
· If you experience difficulty copying and pasting or dragging Corel GALLERY 1,000,000 items into different 

applications, try using the Paste Special command if it is available in the target application.

To drag clipart or a photo to your project
1. Open your project in the destination application.
2. Drag a thumbnail from the Thumbnail View area of any page in Corel GALLERY to your project.

To copy and paste a piece of clipart or photo
1. Open your project in the destination application.
2. Right-click a thumbnail in the Thumbnail View area of any page, and click Copy.
3. In the destination application, place the cursor where you want to place the item.
4. In most Windows applications, do one of the following:

· Right-click and click Paste.
· Click Edit, Paste.

To convert clipart or a photo and add it to your project
1. Click a thumbnail in the Thumbnail View area of any page.
2. Click the Convert button.
3. Choose a folder from the Save In list box.
4. From the Save File As Type list box, choose a file format that the destination application supports.
5. Choose a color depth in the Color Depth list box.
6. Type a filename in the File Name box, click Convert.

If the Import Into Bitmap dialog box opens, choose the same color depth in the Color list box as you choose in 
the Color Depth list box in the File Conversion dialog box. If you do not choose the same color depth, the 
conversion may fail.

7. Open the file in the destination application.
8. In the destination application, follow the procedure to insert a graphic or picture into the file.
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Using clipart and photos in popular applications
The next four procedures will take you through the process of adding clipart and photos to popular software 
applications: Corel WordPerfect, Microsoft Word, Corel Presentations, and Microsoft PowerPoint. Each of these 
procedures is only one way to add clipart and photos to these applications. These procedures will work in most 
Windows-based applications.

To use clipart in Corel WordPerfect
1. Open the document in Corel WordPerfect.
2. Drag the thumbnail from the Thumbnail View area on the Corel GALLERY desktop to the document in Corel 

WordPerfect.
3. Resize the clipart image.

To use a photo in Microsoft Word
1. In Corel GALLERY, click the thumbnail in the Thumbnail View area.
2. Click the Convert button.
3. Choose a folder from the Save In list box.
4. Type a filename in the File Name box.
5. Choose Windows Bitmap (.BMP) from the Save As Type list box.
6. In Microsoft Word, click Insert, Picture.
7. Choose the folder in which your photo is stored from the Look In list box.
8. Type the filename of your photo in the File Name box. 

To use clipart in Corel Presentations
1. In Corel GALLERY, right-click the thumbnail in the Thumbnail View area and click Copy.
2. In Corel Presentations, right-click a slide and click Paste.

To use a photo in Microsoft PowerPoint
1. Open the presentation in Microsoft PowerPoint.
2. Drag the thumbnail from the Thumbnail View area on the Corel GALLERY desktop to the slide in Microsoft 

PowerPoint.
3. Resize the photo.
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Saving clipart and photos to your computer
You can save Corel GALLERY 1,000,000 clipart and photos in folders stored on your computer. This lets you add 
items to your projects without using the Corel GALLERY 1,000,000 CD-ROMs. You can save these items to their 
original file format or to other file formats.

To save clipart or a photo
1. Right-click a thumbnail in the Thumbnail View area of any page, and click Copy.
2. Click the Browse tab.
3. Right-click the folder in which you want to store the item, and click Save.

 Note
· In the Browse page, you can also save clipart and photos by dragging a thumbnail from the Thumbnail View 

area to the folder in which you want it saved.

To convert clipart or a photo to another file format
1. Click a thumbnail in the Thumbnail View area of any page.
2. Click the Convert button.
3. Choose a folder from the Save In list box.
4. Choose a file type from the Save File As Type list box.
5. Type a filename in the File Name box.
6. Choose a color depth in the Color Depth list box.
7. Click Convert.
8. If the Import Into Bitmap dialog box opens, choose the same color depth in the Color list box as you choose in 

the Color Depth list box in the File Conversion dialog box. If you do not choose the same color depth, the 
conversion may fail.
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Renaming clipart and photos
You can rename clipart and photos you have saved to your computer.

To rename clipart or a photo
1. Click the Browse tab.
2. Double-click the folder in which the item is stored on your computer.
3. Click the item you want to rename.
4. Click File, Rename.
5. Type a name for the item.
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Printing clipart and photos
You can use Corel GALLERY to send clipart and photos to print from their associated applications if these 
applications are installed on your computer. When you send an item to print, its associated application launches 
automatically.

To print clipart or a photo
· Right-click a thumbnail in the Thumbnail View area of any page, and click Print.

 Notes
· If you do not see Print on the menu that appears when you right-click a thumbnail, that item cannot be printed

from Corel GALLERY.
· Corel GALLERY 1,000,000 photos are associated with Corel Photo House.
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Editing images
You can use Corel GALLERY to open clipart or a photo in its associated application for editing. The associated 
application launches automatically if it is installed on your computer.

To edit clipart or a photo in its associated application
1. Double-click a thumbnail in the Thumbnail View area of any page to open the image in its associated 

application.
2. Edit the image.
3. Save the image to a folder on your computer.

 Notes
· You cannot save images to the Corel GALLERY 1,000,000 CD-ROMs.
· Though Corel Photo House is a bitmap editor, and Corel GALLERY 1,000,000 clipart is in vector format, you can

edit Corel GALLERY 1,000,000 clipart in Corel Photo House, however, they will be treated as bitmaps. If you 
want to keep the clipart as vector images, edit them in CorelDRAW or another vector image editor.

· For more information about bitmaps and vector images, see Understanding vector and bitmap images.
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Working with Web images and animations

Web images are images for special use in HTML documents. Animations are animated GIFs Web images that 
move. You can use Corel GALLERY to save Web images and animations to folders stored on your computer.

Adding Web images and animations to your HTML documents
How you add Web images and animations to your HTML documents depends on the HTML editing application you
use. For information about adding Web images and animations in your HTML documents, please see the 
documentation included with your HTML editor.
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Saving Web images and animations
You can save Corel GALLERY 1,000,000 Web images and animations to folders stored on your computer. Web 
images and animations can be saved from the Search, Browse, or Favorites page.

To save a Web image or animation
1. Right-click a thumbnail in the Thumbnail View area of any page, and click Copy.
2. Click the Browse tab.
3. Right-click the folder in which you want to store the item, and click Save.

 Note
· In the Browse page, you can also save Web images and animations by dragging a thumbnail from the 

Thumbnail View area to the folder in which you want it saved.
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Renaming Web images and animations
You can rename Web images and animations you have saved to your computer.

To rename a Web image or animation
1. Click the Browse tab.
2. Double-click the folder in which the item is stored on your computer.
3. Click the item you want to rename.
4. Click File, Rename.
5. Type a name for the item.
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Printing Web images and animations
You can use Corel GALLERY to send Web images and animations to print from their associated applications if 
these applications are installed on your computer. When you send an item to print, its associated application 
launches automatically. Web images and animations can be printed from the Search, Browse, and Favorites 
pages.

To print a Web image or animation
· Right-click a thumbnail in the Thumbnail View area of any page, and click Print.

 Note
· If you do not see Print on the menu that appears when you right-click a thumbnail, then that item cannot be 

printed from Corel GALLERY.
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Working with sounds and videos
Corel GALLERY lets you add sounds and videos to projects you create in other applications. You can also save 
sounds and videos to your computer.
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Adding sounds and videos to your projects
Corel GALLERY gives you two ways to add sounds and videos to projects. You can drag an item from the Corel 
GALLERY desktop to the destination application; or copy an item to the Clipboard, then paste it into your project.

To drag a sound or video into your project
1. Open your project in the destination application.
2. Drag an icon from the Thumbnail View area of any page in Corel GALLERY to your project.

To copy a sound or video to your project
1. Right-click an icon in the Thumbnail View area in any page, and click Copy.
2. Open the file in the destination application.
3. Place the cursor where you wish to place the item.
4. Right-click and click Paste.

 Tip
· You can also click Edit, Paste to paste the contents of the Clipboard in most applications.
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Saving sounds and videos to your computer
You can save Corel GALLERY 1,000,000 sounds and videos in folders stored on your computer. This lets you add 
items to your project without using the Corel GALLERY 1,000,000 CD-ROMs.

To save a sound or video
1. Right-click an icon in the Thumbnail View area of any page, and click Copy.
2. On the Browse page, double-click the folder in which you want the item saved.
3. Right-click, and click Paste.

 Tip
· In the Browse page, you can also save sounds and videos to your computer by dragging an icon from the 

Thumbnail View area to the folder in which you want it saved.
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Renaming sounds and videos
You can rename sounds and videos you have saved to your computer.

To rename a sound or video
1. Click the Browse tab.
2. Double-click the folder in which the item is stored on your computer.
3. Click the item you want to rename.
4. Click File, Rename.
5. Type a name for the item.
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The convert button lets you save an item to your computer's hard drive with a different file format than the one 
used on the Corel GALLERY 1,000,000 CD-ROMs.
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The File menu lets you
· open items
· save items to folders stored on your computer from the Corel GALLERY 1,000,000 CD-ROMs
· create shortcuts
· delete items from the Favorites folders
· rename items stored on your computer
· view object properties
· exit the application



The Edit menu lets you
· cut and copy items to the Clipboard
· paste items from the Clipboard
· add items to your Favorites folders
· select items in the Thumbnail View area



The View menu lets you
· display and hide the Toolbar and the Status Bar
· change how items are displayed in the Thumbnail View area



The Help menu lets you
· access online Help and application information.



The Up One Level button goes up a level in the Browse page.



The Add To Favorites button places a copy of the selected item in a Favorites folder.



The Convert button saves a selected item to your computer with a different file format.



The Cut button places a selected item on the Clipboard.



The Copy To Clipboard button places a copy of a selected item on the Clipboard.



The Paste button places a copy of the Clipboard contents in the active area



The Delete button deletes the selected item from the Favorites page



The Properties button displays the file attributes of a selected item.



The Thumbnail view area is where icons or thumbnails are displayed



The Status Bar shows information about such things as objects, ongoing operations, and mouse position.



The Search page lets you find clipart and photos by searching through keywords.



The Browse page lets you find items by accessing categories on the Corel GALLERY 1,000,000 CD-ROMs.



The Favorites page lets you organize items you use often and access them quickly.
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Bitmap
An image composed of a series of pixels or dots. Scanners and paint programs, such as Corel Photo House, 
generate this type of image. By contrast, CorelDRAW creates images using vector objects shapes stored 
internally as mathematical equations. Corel GALLERY 1,000,000 photos are bitmap images.



Color mode
Determines the range of colors and tones that are available in an image, and is usually measured by the number
of colors displayed, for example 256 colors, or 16 million colors.
The color mode you select for your image affects the file size, as well as the quality of the final image that is 
printed or displayed on a monitor. Color mode is identified by a number of bits.



CMYK
A color mode made up of cyan (C), magenta (M), yellow (Y), and black (B). In the CMYK color mode, color values 
are expressed as percentages, so a value of 100 for any ink means that it is being applied at full saturation. Used
in most full-color commercial printing, CMYK is like CMY, but the addition of black allows for true blacks and a 
wider tonal range. The CMYK color mode is based on the CMYK color model.



Pixel
Short for picture element. Pixels are dots on a computer or television screen that combine to form an image. 
Computer images are created as an array of such dots, each having a specific color.



File compression
Computer files are often stored in a compressed format to save space on your hard disk. There are several 
compression techniques that can be used, depending on the original file format. Generally, the more compressed
a file is, the slower it is read to and/or written to.
Compression can be lossless or lossy. Lossless compression retains all the original data through the compression 
and decompression processes. Lossless compression is recommended for storing text or numerical data, such as 
spreadsheets. Lossy compression loses some of the original data, but depending on your requirements, this loss 
may not make a difference in the final result of your work. Lossy compression can compress your original files to 
a much greater extent than lossless compression, and so it may be desired when disk space is at a premium.



World Wide Web (WWW)
The graphical component of the Internet. Text and images are displayed on Web sites using HTML coding and GIF
and JPEG picture formats. Web documents can be viewed using an Internet browser.



Filter
A program that translates one file format to another or that processes the information in a file to produce a 
special effect, such as embossing.



Metafile
A metafile is a file format that can contain bitmaps, vector images, and text.



Vector graphics
Graphics created in programs such as CorelDRAW in which shapes are represented as a series of lines and 
curves. Vector graphics are also referred to as object-based graphics or line art. This contrasts with bitmap 
graphics, which are created pixel by pixel in paint programs and by scanners. Corel GALLERY 1,000,000 clipart 
images are vector graphics.
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Year 2000

Operating System (OS) Date Limitation Of January 18, 2038
For many applications, including non-Corel applications, when the operating system date is January 18, 2038 or 
later, using the application can result in an GPF (General Protection Fault) or other problems. This is not specific 
to Corel software, but is due to the way the C library code handles date/time information.

Date Display
You can display the date with an explicit century (4-digit year) in the Browse or Favorites page.

To change the Short Date Style
1. Click the Start button on the Windows 95 taskbar.
2. Click Settings, Control Panel, and double-click Regional Settings.
3. Choose a date style with 4 digits in the year, such as "MM/dd/yyyy", in the Short Date Style list box.

Corel's Year 2000 Web Site
Corel Corporation has a Year 2000 policy web site. For the latest information, see "What Does the Year 2000 
Mean to Corel Users?" at http://www.corel.com/2000.htm.



Uninstalling Corel GALLERY
You can remove Corel GALLERY from your computer and reinstall it at any time.

To uninstall Corel GALLERY
1. Click the Start button on the Windows taskbar.
2. Click Programs, Corel GALLERY 3, Setup And Notes, Corel Uninstaller.
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Image file formats
The following is a list of the file formats to which Corel GALLERY can convert images. For information about each 
file format, click the highlighted text.

Saved image file formats
Adobe Photoshop (PSD)
CompuServe Bitmap (GIF)
Corel Compressed Exchange (CCX)
Corel PHOTO-PAINT 6 (CPT)
Corel PHOTO-PAINT 7 (CPT)
Corel Presentation Exchange 5.0 (CMX)
Corel Presentation Exchange 6/7 (CMX)
Corel WordPerfect Graphic (WPG)
Enhanced Windows Metafile(EMF)
JPEG Bitmap (JPG)
Kodak FlashPix (FPX)
PaintBrush (PCX)
Portable Network Graphics (PNG)
TIFF Bitmap (TIF)
Wavelet Compressed Bitmap (WI/WVL)
Windows Bitmap (BMP)
Windows Metafile (WMF)
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Adobe Photoshop (PSD)
Corel GALLERY can convert images to the PSD file format. PSD is the filename extension for Adobe Photoshop 
files. The PSD file format is bitmap based.
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CompuServe Bitmap (GIF)
Corel GALLERY can convert images to the GIF file format. GIF is the filename extension for CompuServe Bitmap 
files. The GIF file format is bitmap based and is supported by the World Wide Web, MS-DOS, Macintosh, UNIX, 
Amiga, and other platforms.
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Corel Compressed Exchange (CCX)
Corel GALLERY bitmaps are stored in the CCX file format. CCX is the filename extension for Corel Compressed 
Exchange files. These files are ideal for use in most Corel applications, such as CorelDRAW, Corel PHOTO-PAINT, 
and Corel VENTURA 8.
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Corel PHOTO-PAINT 6 (CPT)
Corel GALLERY can convert images to the CPT file format. CPT is the filename extension for Corel PHOTO-PAINT 
files. The CPT file format is bitmap based.

 Notes
· The CPT file format is compatible with the RGB TIFF 6.0 file format.
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Corel PHOTO-PAINT 7 (CPT)
Corel GALLERY can convert images to the CPT file format. CPT is the filename extension for Corel PHOTO-PAINT 
files. The CPT file format is bitmap based.

 Notes
· The CPT file format is compatible with the RGB TIFF 6.0 file format.
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Corel Presentation Exchange (CMX)
Corel GALLERY can convert images to the CMX file format. CMX is the filename extension for Corel Presentation 
Exchange files, developed for exchanging information between Corel applications.
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Corel WordPerfect Graphic (WPG)
Corel GALLERY can convert images to the WPG file format. WPG is the filename extension for Corel WordPerfect 
Graphic files. The WPG file format is primarily a vector graphic format; however it can store both bitmap and 
vector data.

{button ,AL(`OVR Reference;',0,"Defaultoverview",)} Related Topics



Enhanced Windows Metafile (EMF)
Corel GALLERY can convert images to the EMF file format. EMF is the filename extension for Enhanced Windows 
Metafile files. The EMF file format is a metafile format used to import graphics from Microsoft Windows-based 
applications. 

{button ,AL(`OVR Reference;',0,"Defaultoverview",)} Related Topics



JPEG Bitmap (JPG)
Corel GALLERY can convert images to the JPG file format. JPG is the filename extension for JPEG File Interchange 
Format files, developed by The Independent JPEG (Joint Photographic Experts Group) Group. The JPG file format is
an international standard for image compression, is bitmap based, and is also known as JFIF (JPEG File 
Interchange Format.)
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Kodak FlashPix Image (FPX)
Corel GALLERY can convert images to the FPX file format. FPX is the filename extension for Kodak FlashPix files. 
The FPX file format is bitmap based.
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OS/2 Bitmap (BMP)
Corel GALLERY can convert images to the BMP file format. BMP is the filename extension for OS/2 bitmap files. 
The BMP file format is bitmap based.
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PaintBrush (PCX)
Corel GALLERY can convert images to the PCX file format. PCX is the filename extension for PaintBrush files, 
which are used in cross-platform applications. The PCX file format is bitmap based.
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Portable Network Graphics (PNG)
Corel GALLERY can convert images to the PNG file format. PNG is the filename extension for Portable Network 
Graphics files. The PNG file format is a relatively new Internet graphics format developed as an alternative to the
GIF and JPG file formats. To display a Web site that uses PNG images, your Internet Browser may require that you
install a plug-in filter that supports this new format. Such plug-ins are readily available on the World Wide Web. 
The PNG file format is bitmap based.
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TIFF Bitmap (TIF)
Corel GALLERY can convert images to the TIF file format. TIF is the filename extension for Tagged Image File 
Format files. The TIF file format is bitmap based and is a standard file format used in most paint, imaging, and 
desktop publishing programs, and with digital scanners. The TIF file format is versatile and compatible with 
Macintosh and PC platforms.
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Wavelet Compressed Bitmap (WI)
Corel GALLERY can convert images to the WI file format. WI is the filename extension for Wavelet Compressed 
Bitmap files. The WI file format is bitmap based and is used for storing bitmap information at high compression 
levels.
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Windows Bitmap (BMP)
Corel GALLERY can convert images to the BMP file format. BMP is the filename extension for Windows Bitmap 
files. The BMP file format was developed as a standard to be used across various platforms and is a good 
general-purpose file format for saving images. The BMP file format does not lend itself well to extensive resizing, 
because the image tends to become smudged or distorted.
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Windows Metafile (WMF)
Corel GALLERY can convert images to the WMF file format. WMF is the filename extension for Windows Metafile 
files. The WMF file format, developed by Microsoft Corporation, can contain vector images and bitmap images.
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Viewing icons and thumbnails



Viewing icons and thumbnails
The Corel GALLERY desktop displays icons or thumbnails of Corel GALLERY 1,000,000 items. A Corel GALLERY 
1,000,000 icon is a pictorial representation of a Corel GALLERY 1,000,000 item. A Corel GALLERY 1,000,000 
thumbnail is a miniature, low-resolution version of a Corel GALLERY 1,000,000 item. Thumbnails let you preview 
images, that is, clipart, photos, Web images, and animations. Even when you are viewing thumbnails, sounds 
and videos are always represented as icons. The only difference between icons and thumbnails is the view of the
way these display the type of item they represent.
The following image displays the difference between icons (left) and thumbnails (right):

You can display icons in a list, and you can view various file properties, such as name, file size, type of file, and date
last modified. You can also change the size of thumbnails.



Viewing icons
You can view items as large icons or small icons. Large icons are easier to see than small icons, however, small 
icons let you view more items at a time.

To view icons
· Do one of the following

· Click View, Large Icons.
· Click View, Small Icons.
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Viewing item information
You can view the file size, file type, and date last modified of each item. You can also view an item's properties, 
such as location, MS-DOS name, date created, and if the item is Read-only.

To view details about items
· Click View, Details.

To view an item's properties
· Click an item in the Thumbnail View area, and click File, Properties.
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Viewing thumbnails
You can view clipart, photos, Web images, and animations as thumbnails.
You can view all bitmap file formats in Thumbnail mode in the View window; however, you can only view the 
vector formats Corel Presentation Exchange (CMX) and Corel Compressed Exchange (CCX) in Thumbnail mode in 
the View window. You cannot view the following vector file formats in Thumbnail mode in the View window:

· CorelDRAW (CDR)
· Enhanced Windows Metafile (EMF)
· Windows Metafile (WMF)
· Corel WordPerfect Graphic (WPG)

To view items as thumbnails
· Click View, Thumbnail.
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Resizing thumbnails
You can resize the thumbnails to make them appear larger or smaller. You can choose a preset size for your 
thumbnails, or you can create a custom size.

To resize thumbnails
1. Click View, Thumbnail Size.
2. Choose a size from the Size box.

To specify a custom size for thumbnails
1. Click View, Thumbnail Size.
2. Type a number in the Width box.
3. Click OK.

 Note
· The number you type in the Width box is the width and height of your thumbnails in pixels.
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